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Installing GGL2
In order to run GGL2, you will need to have Java installed. So, if it's not already installed, you can
download and install it from here.
Once you have Java installed, you have to download the GGL2 package that fits your needs from the
Downloads section in the GearScape website.
GGL2 does not need any specific installation, so the only thing you need to do now is to unpack what
you have downloaded wherever you want to have GGL2 and execute GGL2 (GGL2 in Linux, GGL2.exe
in Windows).
The first time you execute GGL2, you will be asked for the workspace location, i.e., where your
projects will be stored. By default, it's a workspace folder under the GGL2 folder. You can change it
now and even check the Use this as default checkbox if you don't want to be asked again.

Once you have started GGL2 succesfully, you should have a window like this:

Later, if you want to change the workspace location, you can do so by using the File -> Switch
workspace menu.

Hello World
In this tutorial we will learn how to create a new project and execute an automatically generated Hello
World example in GGL2.
First, we have to create a new GGL project. Right click in the package explorer and select New -> GGL
Project:
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A new window will appear, asking for the name and location of the new project. By default, the
location of the project is inside the workspace folder and we don't need to change that. For the
project's name, we can use HelloWorld.
IMPORTANT: It is not possible to use white spaces or strange characters in the project's name.
Although the dialog will not complain, the generated project will have unexpected behaviour.

Now we have a new project in the Package Explorer and a new example.ggl file opened in the GGL
editor in the middle of the window. As you can see, the Hello World example is pretty intuitive:
show 'Hello world!';

Time for the execution. Use the menu GGL -> Execute and wait for the results. Now you should have
a "Hello world!" message in the Console view, at the bottom of the window.
NOTE: If the GGL -> Execute menu is disabled when you try to execute your GGL file, it is because
the editor view is not selected. Click within your code and try again the menu, it should work now.
Now that it is clear how to show things on the console, let's change what we're showing. We can try
numbers:
show 34;

calculations (expressions):
show 34 - 30;

and whatever holding a value: either a literal, a variable or an expression. You can see the GGL
Reference Documentation for more information about literals, variables, expressions, the show
instruction and so on.

Hello Command Line
This tutorial is very similar to the Hello World one: we are going to write and execute a very simple
program with GGL2. However, in this one we won't use any graphical user interface, but the
command-line version of GGL2.
First, we are going to create a folder which will contain our program. Inside this folder we create a
subfolder called src-ggl:

Now, inside src-ggl we will create a new example.ggl file with the following content:

Hello Command Line
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show 'Hello command line!';

And this is how we create our program with a single show instruction that shows the given message;
in this case the message is "Hello command line!".
The next step is to compile the program with the GGL2 compiler: gglc. The compilation is a process
to transform the GGL2 code into something that the machine can execute directly. In our case, GGL2
files are transformed into compiled Java files. To do so, we must open a console (Terminal on linux,
Command prompt on Windows), go to the src-ggl's parent folder using the cd command and compile
the program with gglc:
$ <...>
$ cd hello_command_line
$ gglc

Note that <...> stands for all the necessary cd commands in order to get to the hello_command_line's
parent folder. After some info messages, the program is ready to be executed. Simply use the GGL2
execution tool (ggl) from the same directory and specifying the file we want to execute:
$ ggl example

and the expected message is shown. Note that we don't have to write the .ggl extension when we
execute a GGL2 program since the ggl command already knows that the file we are goind to execute
ends with that extension.
It is also important to notice that each time a file is modified or created, it is necessary to re-compile
again. We can see this in the next compilation flow diagram:

In case we miss the compilation step, we can have two different scenarios:

• We try to execute a new file that we haven't compiled. In this case, the result of the compilation
(those compiled Java files) does not exist we will get an error.

• We try to execute a file we have modified after the last compilation. In this case, we will execute
the result of the last compilation, which does not contain the last modifications. In other words,
we will get the same result as if we have not modified anything.

Executing your script
If you want to execute a script that someone has done for you, or you have found somewhere else,
you have two options: using the GGL editor or the GGL command line.

GGL editor
To execute it with the editor, all you need to do is create a new GGL Project as explained in the Hello
World example, copy the code you want to execute from wherever it is, paste it into the example.ggl
file and execute it. Simple as that.
However, if they provide you a full GGL project with several files, resources, etc. you can import it into
your GGL2 environment. You will have to right-click on the Package Explorer and select Import, then
choose General -> Existing projects into workspace and click on the Select archive file option. Browse
the project file or folder (zipped or not) and click Finish.
NOTE: If you want to import the project with all the tutorials, you can get it from here.

GGL command line
Create the following folder structure:
[-] project-root
 · [-] src-ggl
    · script.ggl

and fill the script.ggl file with the contents of the script.

Executing your script
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Then compile:
$ gglc
Compilation finished without errors.
$ _

and execute:
$ ggl script

If the script has a library name you may need to place it in the right package. See Libraries for more
information.
See Command line for more information on command line usage.

Exploring the application
When we first open the GGL2 application, a lot of menus, views and strange stuff appear. In this
tutorial we will explore the main features of the application, this is, the most commonly used menus,
views and buttons.

Editor
The editor is where you write your GGL code, right in the middle of the window. In the next tutorials
you will learn how to write your own code, but for now, you can check that the editor provides some
useful features such as syntax highlighting or autocompletion. The autocompletion provides you a list
of alternatives for the GGL code at the current cursor position by pressing Ctrl + Space.

Console and Problems views
At the bottom of the window, we can find two different views: Console and Problems. If you have
followed the Hello World tutorial, you will already know that the first one is where the output of our
GGL show instructions go. The second one is where the errors in our code are listed. For example, we
can change the show instruction to this:
show 'Hello World!'

where the ending semicolon is missing and we save the file (File -> Save, Save button in the toolbar
or Ctrl + S). If we click on the Problems view now, we will have something like this:

Exploring the application
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which is telling us that the semicolon is missing. Moreover, if we edit the file but we don't save it, the
editor will be updated but the Problems view will remain the same until the file is saved. For example,
if we rewrite the semicolon the error marks in the editor will grey out but the view won't change:

Outline view
On the right side of the window we can see a Outline view. Here is where the library declaration and
algorithms are shown:

Moreover, it is possible to execute an algorithm with the Execution Wizard. You can find more
information about library declaration, algorithms and the Execution Wizard in the GGL2 Reference
Documentation and in the Using libraries and algorithms tutorial.

Package Explorer
In the Package Explorer is where we find our projects. If you have followed the Hello World tutorial,
you will already have a project in your Package Explorer. If you unfold that project, you will see a tree
like this one:

Outline view
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This is the basic structure for a GGL project. Starting on the bottom of the tree, you can see two
libraries called GGL2 Library and JRE System Library. They contain all the dependencies needed to run
GGL2 and you don't have to worry about them.
Above them you can find a src-ggl folder. This is where you have to create your .ggl files. As you can
see, the example file was created inside this folder. If you want to create a new .ggl file, all you have
to do is right-click on the src-ggl folder and select New -> File. A new dialog will appear where all you
need to do is introduce the name of the file:

You can also create new folders with New -> Folder, just like files. There are three types of folders
which can be seen in the following image. Classic folders (resources in the image) have the purpose
of containing files and other folders, as folders in the operating system.
Additionally, there are source folders (starting by "src" in the image) which have a different icon and
are the root of the tree containing scripts. As said before, in order to create a new ggl script, a new
file must be created inside a source folder (specifically src-ggl).
Finally, packages are just classic folders that are contained in a source folder or other packages, this
is, folders in trees which root is a source folder. The ggl folder inside src-ggl source folder is a
package:

For more information about packages and libraries you can see the Using libraries and algorithms
tutorial.

Outline view
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Plus, you will have noticed that when you right-click on an element of your project, a menu with a
huge amount of options appear. However, in order to make a basic usage of GGL you will need only a
few of them. In fact, aside from creating folders and files, all you need to know is the Refresh option,
which updates the contents of the project in case that something has not been updated correctly
(after an execution, for example) or has been modified externally.
Continuing our trip through the project, we can find a src-gen folder. This is where all the generated
files necessary to execute GGL code are stored. Its content is generated automatically so you will not
need to know what happens in there.
Finally, there's a src-java folder that might contain all the Java files you want to create. Java files are
useful when you want to map certain GGL reader, writer or algorithm to a Java type, but this exceeds
the purpose of this tutorial. You can find more information about Java mappings in the GGL Reference
Documentation.

Toolbar
The toolbar is also full of advanced features, but don't let them overwhelm you. There is only a single
button that you may find useful at the beginning. It is a dark bullet (if you hover your mouse over it, a
tooltip will appear with a Connect to GIS message) and it's purpose is to connect/disconnect from the
GIS applications. You can find more information about the GIS connection in the Interacting with GIS
applications tutorial, but it's important to notice that this button allows you to stop all the
communication from/to the GIS applications and enhance the performance of the environment when
you're not interacting with those applications.

Menus
Again we have lots of options that can seem a little difficult to understand, but at the beginning we
will only need a few of them. We have seen how to execute our GGL code with the GGL -> Execute
menu in the Hello World example. We have also a File and Edit menus that are very similar to most
applications: save and close files, copy, paste, find, replace,... Finally, you can find the preferences for
the whole environment in the Window -> Preferences menu.
In summary, the environment contains tons of features that can be useful at some point, but we don't
need to understand them from the beginning. We can learn the basics exposed here and investigate
the rest on our own or even forget about them since they're not strictly necessary. Plus, since the
whole platform is based on Eclipse, you can find more information in the Workbench user guide.

Using libraries and algorithms
In this tutorial we will learn how to use libraries and algorithms, as well as the Execution Wizard.

Creating a library
Libraries are .ggl files inside a package. Packages are referenced in GGL2 with the path from the
source folder using the dot symbol '.' as separator instead of the slash symbol '/'. For example, you
can create a ggl.examples package by creating a ggl folder in src-ggl and an examples folder inside
the ggl folder. You will then have a ggl.example package in your project (if your packages don't look
exactly as the image, you can try refreshing your project):

Toolbar
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We can now create a mylib.ggl file inside this package in order to have our own library. The only thing
left is to "name" that library. Library names are composed by appending the file name (without the
.ggl extension) to the package name:
<package_name>.<file_name>

To name a library, you just have to declare that name in the .ggl file. In our case, we have to write
this at the very beginning of our mylib.ggl file:
library org.examples.mylib;

And this is how we create a new library. A new empty library. Let's add some algorithms to get a
useful library. You can find more details about algorithms in the GGL Reference Documentation, so
let's skip to practice:
alg max(int a, int b) returns int {
        if (a > b) {
                return a;
        } else {
                return b;
        }
}

alg min(int a, int b) returns int {
        if (a > b) {
                return b;
        } else {
                return a;
        }
}

alg abs(int a) returns int {
        if (a < 0) {
                return -a;
        } else {
                return a;
        }
}

Here we have some algorithms to get the maximum and minimum of two integers and the absolute
value of a single integer. As you can see in the outline view, there is a library declaration and three
algorithms with the parameters and return types. In the next section we will learn how to reference
and use this algorithms as black boxes.
Moreover, it is possible to declare some other components inside a library that will be exported, such
as readers and writers (see section below) or GIS applications (see Interacting with GIS applications).

Referencing a library
Now that we have a working org.examples.mylib library, let's use it from another GGL file. We can use
the already existing example.ggl or create a new one. The important thing is that we tell GGL that we
are going to use our library and this is done by writing an import sentence at the beginning of the file:
import org.examples.mylib;

And then we can call the algorithms in the library at any point of our GGL file. For example, we can
simply show the absolute value of a constant:
show abs(-123);

and, after executing, 123 should appear in the console view. Or we can even use algorithm calls as
paramters for another algorithm call:
show (min(abs(-235), 42));

that shows 42 in the Console view.

Referencing a library
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Fortunately, there are some useful libraries already implemented:

• ggl.csv: Read and write CSV files.
• ggl.geom: Geometry management (see Using geometries).
• ggl.gtf: Read and write GTF (GGL Temporary File) files.
• ggl.math: Basic math functions (ceil, floor, max, min, ...).
• ggl.properties: Read and write .properties files.
• ggl.strings: Basic strings functions (length, indexOf, ...).
• ggl.util: Miscellaneous functions (toInt, toDuble, currentTimeMillis);
• ggl.xml: Read and write XML files.

Executing an algorithm
There are some scenarios where we don't want to include some algorithm as part of our process, but
simply execute them with some certain inputs. In this case we can use the Execution Wizard, which
basically asks for the inputs and executes the algorithm. So let's simply try to execute one of the
algorithms used in the previous section, but using the wizard.
We just have to open the tutorial.ggl file and right click the abs method in the Outline view. Simply
choose Run algorithm and put the -123 in the text area. Click Finish and the 123 output should appear
in the Console view.
This is the most basic usage of the Execution Wizard, but it provides some other interesing options.
Actually, this wizard is generated on-the-fly and shows one page for each input parameter and one
more page for the algorithm output. Let's see in detail what we can found on each page in the
following subsections.

Inputs
Here we can see how it looks like an input page for a param1 parameter:

Executing an algorithm
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For every input (basic types, elements or sequences) there are three input options:

• File: One option is to specify a file that contains the input data for the parameter. We will need to
provide the file name and the reader that will read the file in order to get the data. Whenever we
specify a file that exists, a suitable reader for that file will be chosen automatically from the list.
However, it is possible to change that reader and choose another one from that list manually.

• GIS Layer: Another option is to specify a GIS layer. If the GGL2 environment is connected to one
or more GIS applications, the list will be populated with all the available layers from those
applications. Thus, we can provide the input simply by selecting one of them.

• Text: The last option is to write some code that represents the input. For example, if we want to
specify an integer parameter, we can do it just writing the number in the text area. However, this
area can manage every input, so it is also possible to introduce elements or sequences using this
option.

Finally, an important feature of the execution wizard is validation: each time an input is introduced,
the wizard validates it completely. For example, if we specify a file (or a GIS layer), the wizard will
check that the file exists, the selected reader accepts that file and the type of the value obtained
from that file matches the parameter type. Moreover, if we specify the input via source code with the
text area, all syntactic and semantic validations are performed just as if we were writing code in the
editor. If any of these checks fail, an error message will appear in the top section of the wizard.

Executing an algorithm
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Output
For an algorithm (in this case, a sum algorithm) output, we have a wizard page just like this:

Just like in the input pages, we have three different options for the algorithm output:

• Console: The output will be written to the GGL2 environment console, just as in a show
instruction.

• File: The output will be written to the specified file, with the given format, just as in a write
instruction.

• GIS: The output will be exported to the specified GIS with the given layer name and format, just
as in a show in gis instruction.

NOTE: You can get the project with all the tutorials from here. To import the project into your GGL2
environment, right-click on the Package Explorer and select Import. Choose General -> Existing
projects into workspace and click on the Select archive file option. Browse the tutorials.zip file and
click Finish.

Accessing complex data sources
In this tutorial we will learn how to access complex data sources, how to read, write them, as well as
process their contents easily.

Output
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Using elements and sequences
So far, we just have used integers. There are a few more basic types (byte, double float, string, ...)
that can be used the same way. But one of the most important features in GGL2 is the ability to
create complex data structures.

Sequences
On one hand, we have sequences which are a list of values of a certain type. For example, we can
open a new .ggl file, declare a sequence of strings:
sequenceof string strings;

and initialize it with some values:
strings = ['first', 'second'];

Later you can still add some elements to the sequence:
add 'third' to strings;

and the result of:
show strings;

will be [first,second,third].
Moreover, if we want to access a single element of a sequence, we can do something like this:
show strings[2];

that will result in third (note that the first index is 0).

Elements
On the other hand, we have elements, which are groups of several heterogeneous values. We can
define an element (in the same or in a different file) containing an integer named id and a string
named name:
define MyElement as element {
        int id,
        string name
};

But MyElement only defines the type of an element. We don't have actually any variable that we can
use in our code. We can declare a variable and initialize it this way:
MyElement e = create MyElement{id = 0, name = 'a'};

and if we show it on the Console view:
show e;

we will obtain {id=0,name=a}.
Also, if we want to access a subelement it is possible to do so with the slash symbol '/':
show e/id;

This will output 0 in the Console view.
NOTE: In case that you are going to work with XML files, it is possible to declare also attributes for an
element by prepending the keyword attribute to the subelement declaration:
define MyElement as element {
        attribute int id,
        string name
};

This will represent XML elements such as:

Using elements and sequences
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<MyElement id="1">
        <name>a</name>
</MyElement

In this case, if we want to access a single attribute of an element, we will need to use the '@' symbol:
show e/@id;

Combining both of them
But the greatest thing is that we can combine both. This is, we can have sequences of elements and
elements can be composed of sequences and more elements.
Indeed, typical data sources as postgresql tables, shapefiles, csv, etc. map to such complex data
structures so that when we have a certain variable referencing a full data source, such as a CSV file,
we will have a variable, called for example csv, that will be a sequence of elements where each
element is a single row of the CSV file.
Thus, we can access the id element on the first row of the CSV file this way:
show csv[0]/id;

In the next sections we will learn how to process those complex data structures using SQL-like
predicates.

Reading and writing files
In order to read and write files we need some readers and writers that help us to obtain the data from
the files. In this tutorial we are going to use the CSV reader and writer, but it is also possible to use
some other formats (.properties, SHP, DBF, XML, GTF, ...).
The first thing we need to do is open a new .ggl file and import the CSV library:
import ggl.csv;

And then, simply read a CSV file into our new variable (var):
read CSV 'resources/sample.csv' to var;

Note that in order to this code to work properly, you will need to put this file into a resources directory
in your project. Now we can access the contents of the variable as we will see in the next section, or
write it to another file:
write CSV var to 'resources/copy.csv';

Thus, you will end up having a copy of the sample.csv file inside the resources directory (you might
need to refresh the project in order to see it).

Using SQL predicates
Since now, we have learned how to declare and access single elements sequences and how to read
and write files that contains combinations of them. However, GGL2 offers more powerful processing
capabilities.
Let's try to filter our sample.csv file:
show var filter (var/PROVINCIA == 'GRANADA');

To do this, we have to know that the CSV has a column named PROVINCIA and some of its rows have
a value of 'GRANADA' on it. However, if we don't know this, we can use the show instruction or
autocompletion (Ctrl + Space) after writing csv/.
The previous statement will show a sequence with a lot of elements, such as:
[{CODIGO=18001,NOMBRE=AGR,PROVINCIA=GRANADA},{CODIGO=18002,NOMBRE=ALAMEDILLA,PROVINCIA=GRANADA},

but all of them will have the value GRANADA for the column PROVINCIA.

Combining both of them
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It is also possible to select only some of the fields. For example, if we are interested only in the
CODIGO field, we can write something like this:
show var select(var/CODIGO);

and we will have an output like:
[{CODIGO=00001},{CODIGO=00002},{CODIGO=00003},...]

The problem here is that writing the output to the Console view is a good option if you want to see
something special, but it's not a good solution for producing useful results. To do so, you can assign
the value of an SQL predicate to a variable and then write it as explained in the previous section:
result = var select(csv/CODIGO);
write CSV result to 'resources/codes.csv';

If you want to export your results to a GIS application instead of writing them to a file, see Interacting
with GIS applications.
There are also some other nice features with SQL predicates, such as renaming the processed
variable:
show var select(a | a/CODIGO);

or concatenating predicates:
show var filter(var/PROVINCIA == 'GRANADA') select(a | a/CODIGO);

With this last one you will get only the codes (CODIGO field) of the rows with the value GRANADA on
their PROVINCIA field.
You can find more information about this and more predicates (groupby, expand, join, ...) in the GGL
Reference Documentation
NOTE: You can get the project with all the tutorials from here. To import the project into your GGL2
environment, right-click on the Package Explorer and select Import. Choose General -> Existing
projects into workspace and click on the Select archive file option. Browse the tutorials.zip file and
click Finish.

Using geometries
In this tutorial we will learn how to manage geometries, perform calculations and write the results.
First, we need to know that there is a basic type in GGL for geometries. Thus, we can declare a
geometric variable:
geometry geom;

and use WKT expressions to assign a value:
geom = POINT(0 0);

Obviously, geometries can also be used with sequences and elements, as explained in the Accessing
complex data sources tutorial.
Since we have a ggl.shp library with a SHP reader, let's use it to get some data from two .shp files:
import ggl.shp;

read SHP 'resources/buildings.shp' to buildings;
read SHP 'resources/streets.shp' to streets;

In order to this code to work properly, you will need to put both shapefiles into a resources directory
in your project. You can download the data from here.
Furthermore, we have a ggl.geom library with lots of geometric algorithms that can be used with our
data (ST_Buffer, ST_Area, ...). Note that the algorithm names in this library follow the standard
naming convention ST_*:
import ggl.geom;

Using geometries
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And we are going to obtain which streets are within a given distance from some building. First, we
calculate a buffer over the buildings:
buffer = buildings select(geom=ST_Buffer(buildings/the_geom, 10));

Now, we join the buffered buildings with the streets only where they intersect:
result_join = buffer join streets on (ST_Intersects(buffer/geom, streets/the_geom));

And finally, we get the intersection:
result = result_join select (r| the_geom = ST_Intersection(r/geom, r/the_geom));

Now it's up to you if you want to write your results to a file:
write SHP result to 'resources/result.shp';

or you want to export them to a GIS application as it is explained in the Interacting with GIS
applications tutorial.
NOTE: You can get the project with all the tutorials from here. To import the project into your GGL2
environment, right-click on the Package Explorer and select Import. Choose General -> Existing
projects into workspace and click on the Select archive file option. Browse the tutorials.zip file and
click Finish.

Interacting with GIS applications
In this tutorial we will learn how to reference layers from GIS applications as well as to export our
results in a GIS application. Moreover, we will see how we can configure the GIS applications
integrated so far.

Referencing GIS layers
In order to reference a layer from a GIS application, first both GGL2 and the GIS application must be
connected. There is a connect button in both toolbars that have to be switched on:

The GGL2 button connects/disconnects the editor from all the GIS applications; the button in the GIS
application connects/disconnects the GIS application individually.
Then, all you need to do is write the name of the layer in your GGL2 code. But, since GGL2 can be
connected to several GIS applications, it is necessary to difference the layers that are provided by
them. Thus, the name of the GIS application is added as a prefix to the variable name representing
the layer. For example, if you are connected to gvSIG and GearScape at the same time and there is a
buildings layer in both applications, this code will be completely valid (note that you will need to load
the buildings layer in your GIS application before trying to compile the following code):
import ggl.shp;
import ggl.geom;

show gvsig_buildings select(ST_Buffer(gvsig_buildings/the_geom, 10));
show GearScape_buildings select(ST_Buffer(GearScape_buildings/the_geom, 10));

Note that the rules to name layers in, say, gvSIG are different from the rules to name variables in GGL
so if the layer name in the GIS application doesn't represent a valid identifier in the language it will be
truncated. For example, if we have a layer in gvSIG which name is roads.shp the name used in GGL to
refer to that layer will be gvsig_roads (without the ".shp"), because the dot symbol ('.') cannot be
used for language identifiers. Note that you can write the name of the GIS application followed by an
underscore and press Ctrl + Space for autocompletion to get a list of all the available layers from that
GIS application.
Moreover, it is possible that some of your layers in the GIS cannot be accessed from GGL. This
happens when there is no available reader in GGL that can handle that layer and the workaround
might be to use the GIS application to export that layer to a format that GGL can understand.

Interacting with GIS applications
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Adding new layers to GIS
If you want to include your results as layers in your GIS, first you need to define that GIS:
gis gvSIG;

gis is a reserved word and the next identifier (gvSIG in this case) must match the name of the GIS.
Documentation of the GIS plugin for GGL2 should define the exact name that should be used in that
sentence to connect both GGL2 and the GIS but, in any case, once the GIS plugin is started, it
registers itself with that identifier in a properties file in $HOME/.ggl/gis.properties.
However, since GGL2 has been already integrated in gvSIG, we provide a ggl.gisapps library that
already contains the gis definition. Once this library is imported, it can be used in the show instruction
in order to export the results to that GIS:
import ggl.shp;
import ggl.geom;
import ggl.gisapps;

read SHP 'resources/buildings.shp' to buildings;
show buildings select(ST_Buffer(buildings/the_geom, 10)) in gvSIG as SHP 'buffer';

The syntax for the GIS clause is 'in' *<gis> 'as' <writer> <layer_name>. Thus, you specify in which
GIS you want to export the results, the format and the layer name. It is important to notice that the
name used in the show instruction is the exact name of the layer as it is imported in the GIS, i.e. no
prefix is needed in this sentence. However, if we want to reference that layer later, it would be
necessary to use the prefix (gvSIG_buffer) in order to know where the layer comes from, as explained
above.
Moreover, it is possible to use a default GIS when exporting results so the same code can be reused
for different GIS applications:
show buildings select(ST_Buffer(buildings/the_geom, 10)) in gis as SHP 'buffer';

Here, gis is again a reserved word and represents the default GIS, that can be set or changed in the
GGL preference page (Window -> Preferences -> GGL -> GIS Connection). In this preference page,
only the connected GIS applications appear, so it is mandatory to start the GIS in order to set it as
default. Moreover, the default GIS is not initialized the first time the editor runs, so if you try to export
to the default gis, you will get an error specifying that the default GIS application could not be
determined.
NOTE: Validations are performed at compile time. If the GIS used in the show instruction is not
defined previously, there will be a compilation error. If it is not possible to connect to the GIS
application at compile time, there will be an error. Thus, it is possible to perform a valid compilation,
but get an error when executing if the GIS layers have changed.

gvSIG Plugin
The gvSIG plugin can be configured by using a toolbar button and a menu item in the graphical user
interface. The toolbar button is used for both connect and disconnect the plugin, changing the icon
and tooltip accordingly. When the plugin is connected, a new entry is added to the
$HOME/.ggl/gis.properties file, with the name of the GIS and the listening port of the GIS application.
The name of the GIS, used to declare it within your GGL code is gvSIG.
In order to change this port number, there is a Configure connection menu item, under the GGL2
menu. This menu item opens a very simple dialog where users can change the connection port. If the
plugin is already connected when changing the port number, it is immediately restarted on the
specified port.
Both port number and connection status are stored when closing gvSIG so they can be recovered on
startup.
NOTE: You can get the project with all the tutorials from here. To import the project into your GGL2
environment, right-click on the Package Explorer and select Import. Choose General -> Existing
projects into workspace and click on the Select archive file option. Browse the tutorials.zip file and
click Finish.

Adding new layers to GIS
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GGL2 Reference Documentation
Contents:

Introduction
GGL2 is a language intended to make geoprocessing easy by providing the basic constructions and
semantics to perform vector and raster operations.
Language is described in this documentation, examble by example.

Language basics
GGL2 is a language specifically designed to process data. This means that it provides constructions to
read, transform and store different data structures from several types of sources. In this section, the
basic units of data are explained.

Literals
In GGL2 each value managed by the language must have a known type. Literals are just constant
values used in the code with some indication about the type. In the following table we have the basic
types in GGL2 along with a description of the type indicator and some examples:

Type Indicator Example
boolean true or false true, false
byte ending b 2b
short ending s 2s
int just any number with no ending letter 2
long ending l 2l
float ending f 2f
double ending d or decimal number without ending letter 2.0, 2d
date no literal dates so far
string single quoted '2'
geometry no literal geometries
raster no literal rasters

In order to create a value of a certain type the corresponding syntax must be used. Thus, to show a
string in the console it is necessary to write the value and surround it with single quotes:
show 'hi';

while integers can be shown by just typing the number:
show 4;

Variables
It is possible to store literals in variables. Variables have a name, a type and, possibly, a value.
One way to create a variable is to write the type and the name of the variable. In the following
example, the variable called i would have an int type and no value:
int i;

In order to give it a value we can initialize the variable with a literal:
int i = 10;

GGL2 Reference Documentation
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Note that although there are some implicit type conversion capabilities, it is not possible to initialize a
variable to a literal of a type different from the one of the variable. For example, the following
initialization is wrong:
string mystring = 2;

but this one is correct:
string mystring = '2';

Note that it is not necessary to specify the type of the variable if it is possible to infer it from the
initalization. For example, the previous examples could have been written like this:
i = 10;
mystring = '2';

because the type can be guessed from the type of the literal the variable is initialized to.
Variable initializations can have literals, but also other variables:
string str = 'hello world';
string anotherString = str;

and any expression in general.

Expressions
An expression is just a language construction that takes one or more values and produce other
values. There are several types of expressions and some of those dealing with simple values (those
seen so far) will be presented.

Mathematical operations
It is possible to obtain the sum, subtraction, multiplication and division of two numeric values by
typing them separated by the corresponding operator:

Operation Operator Example
Sum + 3+5, a+2
Subtraction - 3-5, 2-a, a-2
Multiplication * 3*4
Division : 5:2

String concatenation
When the operators are strings, the '+' operator produces the concatenation of both of them. Thus,
this line:
show 'hello' + 'world';

would produce the string hello world in the console.

Comparison operators
Numeric and string values can be compared with each other using the typical comparison operators.
The result of the expression is a boolean value indicating if the condition holds true or false. Note that
the operands of any expression can be also expressions:

Operation Operator Example
Less < 5<3, a<2, 3*4 < 10
Less or equals <= 3<=5, 2<a, a<2
Greater > 3>4

Expressions
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Greater or equals >= 5>=2
Equals == 5==2, 'ho'+'la'=='hola'
Not equals <>, != 5<>2, 5!=2
Is null is null a is null

For the novel user it may be shocking to have an expression like 5<3. Nothing wrong there, it's just
an expression that takes two numbers (3 and 5) and produces a boolean value (false). The only
difference from, for example, an arithmetical operation is the type of the output value.

Logic operators

Operation Operator Example
And and true and false
Or or false or true
Not not not false

Cast
To do

WKT expressions
Although GGL2 does not provide a syntax to specify geometry literals, it provides a construction to
build geometries using Well Known Text syntax (WKT). Therefore it is possible to type directly WKT
code and assign it to a variable:
geometry g = POINT(10 10);
g = POLYGON((0 0, 10 0, 10 10, 0 10, 0 0));

Additionally, and that is the reason why WKT expressions are not literals, WKT expressions may
contain references to variables:
x = 10;
y = 5;
g = POINT (x y);

And it is even possible to use some more complex expressions provided they are wrapped between
parenthesis:
x = 10;
y = 5;
g = POINT ((x+1) (y+1));

Bounding box intersection operator
The '&&' operator takes two geometric operands and produces a boolean value. This value is equal to
true if the bounding boxes of the geometries intersect and false if they do not:
show POINT(0 0) && POLYGON ((0 0, 10 0, 10 10, 0 10, 0 0));

Algorithms
Algorithms calls are also a type of expression. In order to use an algorithm it is necessary to put their
name before the comma-separated list of parameters used in the call, between parenthesis:
show factorial(4);

For such a statement to work, an algorithm named 'factorial' taking one integer value as parameter
must exist. More information on Algorithms.

Logic operators
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Simple statements
Statements are structures of the language that tell the computer to perform some task. The type of
the task depends on each statement. For example, in previous section there is an example of variable
declaration:
int i;

which is no other thing than the local variable declaration statement.
Statements are separated from each other by a semicolon.

Local variable declaration statement
See Variables to see examples about this section.

Assignment
An assignment changes the value of a variable. It consists of the name of the variable, the '='
operator and the new value of the variable. In the following script the first line declares a geometric
variable called 'center' and the second one assigns the value 'POINT(100 100)' to it:
geometry center;
center = POINT(100 100);

As in local variable declarations initialization, the values that can be assigned to the variable can be
literals, other variables or any expression, provided it has the same type of the variable to be
assigned.

Show
The basic syntax of the "show" command is just the "show" keyword and the literal, variable or
expression which value is desired to show on the console:
show 'hi';
show 4:2;
int a = 4;
show a;

There are plenty of examples for show in previous section. Show command can provide more complex
functionalities when working against some GIS data sources. See GIS connection related sections for
more information.

Assert and Error
Along the development of some process there may be cases where an error message should be
shown to the user in order to provide him with information about a bad usage of some algorithm,
some circumstance that prevents the execution of the algorithm or any other anomalous condition.
The error statement does just that. It consists of the 'error' keyword followed by a string literal with
the message to be shown to the user:
error 'this process will not take place';

When the error has to be shown on a conditional basis the assert keyword can be used. The assert
statement provides a condition that must evaluate to true, otherwise, the specified error message will
be shown:
int a = 0;
assert a == 0 error 'a must be zero!!!';

The statements seen so far does not alter the execution flow. When the script is executed the first
statement is processed, then the second and so on until the end of the script. However, assert and
error may change this, since in both cases when the error message is shown the execution of the
process is stopped and statements that follow the error or assert statement are not executed.

Simple statements
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Another statement that changes the execution flow is the "if" statement.

If
"If" statements allow the user to fork the execution flow depending on the value a boolean expression
takes (the if condition).
A simple example:
int a = 2;
if (a == 2) {
        show a;
}

In this example, the if statement contains one 'show' statement, that will be executed only if a's value
is 2 (in this case, it is). If a had another value the 'show' statement would not execute.
In case there are several exclusive conditions with different lists of statements to be executed in each
case it is possible to specify them by using the 'elseif' syntax:
int a = 2;
if (a == 2) {
        show a;
} elseif (a == 1) {
        show 'a is 1';
}

And it is possible to catch all conditions not matched in the previous cases with the 'else' keyword. In
this case there is no need to provide a condition:
int a = 2;
if (a == 2) {
        show a;
} elseif (a == 1) {
        show 'a is 1';
} else {
        show 'a is different from 1 and from 2';
}

In order to go on with the rest of statements, it is necessary to take a look into the complex data
structures.

Libraries
The previous section consists of several statements that are run on a single file but, typically, a single
file is too simple to organize the different artifacts that can be built with the language. This section
explains how GGL2 functionality can be encapsulated in algorithms and libraries.

Algorithms
The minimal reutilization unit is the algorithm. An algorithm is just a sequence of statements
packaged as a "black box". This means that it is possible to use this black box with the values defined
in a script without looking at what the black box has inside.
An algorithm takes zero or more values as inputs and produces an output value. They are defined by
the alg keyword, followed by the name of the algorithm and the parameters between parenthesis.
Finally the returns keyword, followed by a type defines the type of the output value. For example:
alg sum(double a, double b) returns double {
        return a + b;
}

The body of the algorithm is a sequence of statements wrapped by curly brackets and the output 
value is specified in that body by the use of the return statement followed by the value to return. In 
the previous example, the algorithm takes two double values and produces a double value which is
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the sum of the inputs.
It would be possible to use the algorithm by a simple algorithm call. For example, inside a show
statement:
show sum(12, 4);

Java algorithms
There is a special algorithm that has no body. Well, no GGL2 body, because they are mapped to Java
code. This is useful when the functionality provided by GGL2 is not enough to resolve an specific
problem or there is already some java code that does what is desired.
Information about algorithms implemented in Java can be found in Algorithm mappings.

Libraries
Every file in ggl is a library. When the GGL code is in a file with no library declaration, the algorithms
on that file are meant to be in the default or anonymous library. In order to reuse the code on that
files it is better to give the library a name. Like 'test.math' in the following example:
library test.math;

alg sum(double a, double b) returns double {
        return a + b;
}
alg multiply(double a, double b) returns double {
        return a * b;
}

There are three rules to follow when creating libraries:

• Library names must have at least two parts separated by a dot.
• The last part of the library name must match the ggl file name.
• The rest of the library name must match the folder structure the ggl file is in.

Thus, in the previous example, the file must be located in the "test" directory and be called
"math.ggl".
To reuse the algorithms in a library from another file, it is necessary to import the library:
import test.math;

show sum(2, 2);
show multiply(2, 2);

or to use their fully qualified name (library name as prefix):
show test.math.sum(2, 2);
show test.math.multiply(2, 2);

This way it is possible to have different algorithms with the same name, provided that they are on
different libraries.

Data Structures
So far, GGL2 is little more than an arithmetic-logic language with some string and geometries simple
operations. What makes of GGL2 a tool to treat spatial data is the possibility to extract and populate
more complex data structures: XML files, databases, etc.

Type definitions
As can be seen next, GGL2 provides ways to create new data types. In order to give them a name it is
necessary to use the define statement. For example, although they already have a name, we could
give int type another name like this:

Java algorithms
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define integer as int;
integer a = 3;
int b = 2;
a = b;

In the following sections this define statement will be used to give names to the created data
structures.

Sequences
Sequences, are data structures that hold zero or more values of any type (including other sequences).
The way to define a sequence is to put the keyword 'sequenceof' before the name of the base type:
sequenceof int myInts;

As it can be seen, there is no initialization in the previous variable declaration so myInts has no value.
In order to populate the sequence it is possible to use a sequence literal. Sequence literals consist of
a list of values between square brackets:
sequenceof int myInts = [0, 1, 2, 4];

The base type of the sequence literal is the type of the first element of the sequence. In case it is an
empty sequence, it is necessary to specify explicitly the type:
sequenceof int myInts = [as int];

There is also the possibility to add elements to a sequence value by using the add statement:
add 7 to myInts;

and it is possible to insert the element into an specific position, shifting one place all the elements
from the given position until the end of the sequence one place:
add 3 to myInts at 3;

Although it is not very common, is possible to give a name to sequence types with the define
statement seen before:
define ints as sequenceof int;
ints myInts = [0, 1, 2, 3, 4];

Finally, in order to access individual values of a sequence it is possible to use the square bracket
operator '[]' and using a 0-based index to specify the sequence value we want to access:
sequenceof int myInts = int[][0, 1, 2, 4];
show myInts[2]; // Will show a 2
show myInts[3]; // Will show a 4

Note that, although this may seem a simple way to access sequence values it is not the preferred way
and works well only on sequences created from literals (all seen so far).

Elements
Elements are data structures that contains several pairs key/value. The keys are identified by their
name and they may be either attributes and children. There is no difference between them except
when an element is written to an XML file, in which case attribute keys are translated to an XML
attribute while child keys are written as new elements.
Inside GGL, attributes must be referenced with a prepending "@" and can hold just simple values (not
sequences nor elements). In the other hand, children can be also complex structures: elements or
sequences.
The way to define an element structure is to provide between curly brackets the comma-separated
list of sub-elements with an attribute/child qualifier:
element {
        attribute int id,
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        attribute string name,
        child text description
}

The child keyword can (and will) be omitted:
element {
        attribute int id,
        attribute string name,
        string description
}

Thus, we can create new data types of interest for specific tasks and declare variables of those types.
For example, the following local variable declaration creates a variable of the type specified before:
element {
        attribute int id,
        attribute text name,
        string description
} myElement;

However, it is better to give the element a name with the type definition statement, so that we can
create new variables easily:
define MyElem as element {
        attribute int id,
        attribute string name,
        string description
};
MyElem myElement1;
MyElem myElement2;

Element Creation
As it may be noted, the previous variable declarations contain no initialization. Therefore the variable
has no value. With simple types it was quite straightforward to initialize the variable but in the case of
complex structures it is necessary to provide some language construction in order to create an
element.
This can be done in two ways.
The element creation expression provides a way to build an element and populate optionally their
sub-elements:
define MyElem as element {
        attribute int id,
        attribute string name,
        string description
};
MyElem myElement = create MyElem{@id = 0, description = 'This element has no name yet!'};

Note that in the previous initialization myElement has a value that is an element, with its 'id' attribute
and its 'description' child set but with no value in its 'name' attribute.
Another way to create elements is to use the anonymous version of the previous expression by
removing the "create <Type>" at the beginning:
myElement = {@id = 0, description = 'This element has no name yet!'};

however, in this case, as the name attribute is not populated (since the system does not know which
type to instantiate), the resulting element will not contain that attribute and will be equivalent to this
named creation:
define MyElem as element {
        attribute int id,
        string description

Element Creation
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};
MyElem myElement = create MyElem{@id = 0, description = 'This element has no name yet!'};

In order to set the name attribute to no-value by using the null keyword:
myElement = {@id = 0, @name=null, description = 'This element has no name yet!'};

However, contrary to the named element creation where the system knows the type being created, in
the anonymous element creation there is no way to know it, and therefore, to know the type of the
name attribute. Then, it is necessary to cast the null value to the desired type in order to let the
system build the anonymous type:
myElement = {@id = 0, @name=(string) null, description = 'This element has no name yet!'};

Element implicit type conversions
In GGL it is possible to assign a variable of type element any value that contains, at least, the element
attributes and children.
For example, taking the previous declaration:
define MyElem as element {
        attribute int id,
        attribute string name,
        string description
};
MyElem myElement;

The following assignment to an anonymous element will fail:
myElement = {@id = 0, description = 'short description'};

because there is no name attribute in the created element. In order to assign an element to the
myElement variable it is necessary to specify, at least, all the sub-elements of the MyElem type (@id,
@name and description). For example, the following assignment will be valid:
myElement = {@id = 0, @name='RJ45', @width='1.23mm', description = 'short description'};

because it defines all the necessary sub-elements. In this case, the width attribute is ignored.

Structure navigation
Sequences and elements are the key elements to build complex structures. In order to access the
individual components of such structures it is possible to reference the data structure and the desired
sub-element with slash operator '/':
show myStructure/mySubElement;

In the case of elements the slash operator returns the sub element:
define MyElem as element {
        attribute int id,
        attribute string name,
        string description
};
MyElem myElement = create MyElem(@id = 0, description = 'This element has no name yet!');
show myElement/@id; //will show 0
show myElement/@name; //will show null
show myElement/description; //will show This element has no name yet!

If instead of an element, the left of the slash operator is a sequence, the element inside the sequence
(in case of sequences of elements) is accessed and the result is a sequence containing the values of
the specified sub-elements inside every element in the sequence.
For example:

Element implicit type conversions
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define Student as element {
        attribute string name
}
sequenceof Student class;

show class/@name; // Will show a sequence of all students names

Rasters
GGL provides a raster datatype that represents a square matrix of numeric values called "samples".
It is possible to access the width and height of a raster as it were an element containing two int
children called width and height:
raster myRaster = ...;
show myRaster/width + "-" + myRaster/height;

Although the same slash "/" operator is used, there is no raster type definition with the define
keyword because raster datatype is a built-in type.
Apart of the width and height properties, it is also possible to access specific sample values with the
square bracket operator "[]" indicating the x and y coordinate of the desired samples:
show myRaster[0, 0];

Samples start at the 0, 0 position in the upper-left corner and grow right and downwards. Also note
that the pixel access operator is different from the sequence access since it takes more than one
index separated by commas.
More on how to operate with rasters can be read in Rexp

Data access
An experienced user may have already noted that the data model of shapefiles, for example, may be
modeled by using a sequence of elements with one geometric child and a variable number of
alphanumeric children. Thus, a shapefile containing a numeric field could be modeled like this:
define MyFeature as element {
        attribute geometry the_geom,
        attribute int id
};
define MyShape as sequenceof MyFeature;

However, the defined data structures contain no data and there is no use in processing empty data.
Indeed, there is another, most interesting, usage for data structures. By using the read statement it is
possible to create variables containing data read from some source with its very same structure.
Thus, if the previous example shapefile is stored in "/tmp/myshape.shp", the following script:
import ggl.shp;

read SHP '/tmp/myshape.shp' to myShape;

would create a myShape variable pointing to the shapefile data and with the same data structure
defined in previous example.
More on read can be seen on I/O statements

Processing statements
In this section a complete reference of the statements to perform geoprocessing tasks is presented.

Rasters
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I/O statements
As there is no use for a geoprocessing language if it is not capable of dealing with existing data, GGL
provides several statements to read and write values to and from data sources.
The read statement makes it possible to "link" a variable to a data source, while write and show are
able to write values (either basic or complex data structures) to disk, or databases, etc.

Read
read simplest form is like this:
read <READER> 'data_source_url' to <varname>;

where the READER must be a reader declaration, for example SHP or XML.
The data_source_url is a string literal that points to the data source that is required to be read. This
can be understood as an URL, but it's syntax depends on the reader. For example, if the SHP reader is
used, a file path is expected. If a POSTGIS reader is used, a JDBC connection string should be used.
Therefore, it is necessary to read the reader documentation in order to know the type of the url
expected.
Once the read statement is placed on a script, the variable has the contents of the data source
located at the specified URL.
For example, in the case of a shapefile the data structure read is a sequence of elements (features)
so we could access any of these elements and show some of its subelements (feature attributes). In
the following example, the geometry of the first feature in the shapefile is shown:
import ggl.shp;

read SHP '/tmp/buildings.shp' to myshp;
show myshp[0]/the_geom;

Two importants things to note about this example. First, the myshp variable is declared in the read
statement so there is no need to declare it before.
Second, the square bracket operator "[]" is discouraged since its efficiency is quite poor. It can be
used with small sequences with no problems but in order to process something different to very small
sequences it should be avoided.
The syntax seen so far is the simplex expression of the read statement. There are two more clauses
that can be used:
read <READER> 'data_source_url' <properties> to (<type>) <varname>;

Indeed, with the previous syntax it is not possible to provide the driver with information to help him
read the data in the proper way. A good example of this need is the shapefile encoding, that is not
provided in the DBF file and must be specified externally.
This is done with an anonymous element creation:
read SHP '/tmp/buildings.shp' {
        encoding='utf-8'
} to myshp;

Again, the properties that can be specified depend on the reader. For example, the comma separated
values (CSV) reader accepts an "encoding" and a "separator" property to specify the character to
separate the fields:
read CSV '/tmp/test.csv' {
        encoding='iso-5589-1',
        separator=';'
} to mycsv;

For a complete list of the available readers and the supported properties, see Readers and writers.
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Finally, the <type> syntax allows to specify the type of the data in the data source. This may be
necessary because GGL2 checks at compile time that the different operations are valid given the
input types and, therefore, every variable in a script must have a type. If the reader is not capable of
providing the type information, it is necessary to provide it manually with the <type> clause.
This is not usual, but there are certain situations where the reader is not able to access the data
source. For example:

• The data may not exist at compile time.
• The properties values are not literals. In the previous examples, all

the property values are string literals. If an expression is used (some algorithm call, some variable
usage, etc.) it is not possible to know at compile the properties values and therefore the reader
cannot inspect the data source properly.

Write
Again, GGL would be an useless language if it were not possible to write the results to a known format
that can be read by other applications. This can be done with the write statement whose syntax is the
following:
write <WRITER> <variableReference> to 'data_source_url' <properties>;

which is very similar to the read one except that instead of a reader, a writer is referenced and the
order of the clauses are reversed.
For example to write the contents of a variable to a shapefile, this syntax should be used:
write SHP mycontents to '/tmp/result.shp' {
        encoding='utf-8'
};

where mycontents is a variable containing a data structure that is accepted by the SHP writer.
This last issue is very important. Obviously it is not possible to store a single string into a shapefile. In
order to successfully store data in a shapefile it is necessary to provide the data shapefiles are able to
store which is a sequence of elements containing a geometric subelement.
If the data to be written is not supported a compile error will be shown.
See Readers and writers for a complete reference of the data writers accept.

Show
show has a similar function to the one of write, only that the written data is shown to the user.
In order to show some data, the following syntax will be used:
show <expression> [in <GIS> as <WRITER> <layername> <properties>];

As the code between square brackets is optional, the simplest way to show some data is like this:
show 3+4;
show myvar;
show myAlg();
...

This way, the data will be shown in the standard output of the environment. What this standard
output is depends on the environment the script is executed in. For example if the script is executed
in command line, that same command line will receive the show data, whereas if it is executed in the
graphical environment, it will be shown in the Console view.
However, GIS data showing on the console is not very useful. Although the geometries are shown in
WKT, it is generally a graphical view of the data what is required. And that is the purpose of the
optional code.
GGL is able to connect to several GIS applications in order to send them the data the user wants to 
visualize. By using the extended form of the show statement, the language sends the data to a GIS
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application and asks it to show it on a map:
show myResult in gvSIG as SHP 'myResult';

As it is possible to connect to several GIS applications, the show statement requires the identifier of
the GIS application the script should communicate to. This is "gvSIG" in the previous example.
However, it is usual to configure the default GIS application and use a generic "gis" keyword to
reference it. Then, the following statement will show the result in the default GIS:
show myResult in gis as SHP 'myResult';

The communication with the GIS application is done by writing the result to a file that can be
accessed by the GIS application. In the previous example, the data is writen to a temporal shapefile
format.
Finally, the string literal 'myResult' is the name the GIS application will use to load the temporal file.

Available GIS applications
Currently, only gvSIG there can be accessed from GGL. In order to reference it directly it is necessary
to import the "ggl.gisapps" library:
import ggl.gisapps;
show myResult in gvSIG as SHP 'myResult';

Foreach
The foreach statement allows the execution of some code for every element of a sequence. Its syntax
is as follows:
foreach <var> in <sequence> {
        <statements>
}

and it tells the GGL interpreter to execute the specified statements for each element in the sequence,
which will be referred by the variable var.
For example, in order to get the addition of the first 10 natural numbers it is possible to use a foreach
statement:
int accum = 0;
seq = 1 .. 10;
foreach elem in seq {
        accum = accum + elem;
}
show accum;

Inside foreach blocks it is possible to control the execution flow to keep some statements to be
executed. The continue keyword stops immediately the current iteration and starts a new one with
the following element of the sequence. This may be useful if no prime numbers are to be taken into
account:
int accum = 0;
seq = 1 .. 10;
foreach elem in seq {
        if (isPrime(elem)) {
                continue;
        }

        accum = accum + elem;
}
show accum;

However, if no more iterations are desired, break should be used instead. For example, the following
code adds the first prime numbers in the set of natural numbers (1, 2 and 3):
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int accum = 0;
seq = 1 .. 10;
foreach elem in seq {
        if (not isPrime(elem)) {
                break;
        }

        accum = accum + elem;
}
show accum;

Create index
In order to evaluate efficiently the Joins and the Filter predicate it may be interesting to create an
index on one of the fields involved in those expressions.
Indices can only be built on sequences of elements (flat files). Consider the following sequence:
seq = [

{the_geom=POINT(0, 0}, name='aa120'}, {the_geom=POINT(3, 2.5}, name='aa122'}, ...
{the_geom=POINT(0.2, 12}, name='ab20'},

];
and the following filter getting just the elements whose name starts with 'ab':
import ggl.strings;

abElements = seq filter(e| startsWith(e/name, 'ab'));

If the sequence seq is very long it may take some time to filter it and if that filtering is going to be
done multiple times, it is better to create an index on the name sub-element:
create index seq(name);

The speed up for filters pay only in case the filtering is done several times (inside a foreach block for
example). However, in the case of joins, it is absolutely necessary to create indices in order to get
good execution times. So necessary that it is not necessary to build the index explicitly and the join
will do it automatically if no index is available.

Processing expressions
Apart of the basic expressions seen in Expressions, there are more complex ones that are interesting
to process complex data.

Spatial value processing
Although rasters and geometries are basic types, there are constructions to access their contents and
produce new rasters and geometries. These are the gexp and rexp expressions.

Gexp
The geometric expression, or gexp, is a construction that takes a geometry as input and produces
another geometry as a result. The syntax of the simplest gexp expression is as follows:
gexp <geometric_expression> eval ( [alias |] <coordinate_expression>)

where the geometric_expression is the input geometry and the coordinate_expression is an
expression that gets evaluated for every coordinate in the input geometry. In this evaluation it is
possible to reference the input geometry coordinate with the name of the input geometry, if the
expression was just a variable reference, or with the alias, if one is specified.
The resulting geometry is expected to be a point, which is used as coordinate of the output geometry.
In case of a resulting geometry with more than one coordinate, any of them is taken and no
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deterministic behavior is assured.
Consider the following example. ST_X ad ST_Y are algorithms that return the x and y ordinates of the
specified geometry respectively. The following code:
geometry input = POLYGON((0 0, 10 0, 10 10, 0 10, 0 0));
show gexp input eval(snapToGrid(input));

will create a new geometry taking input as input and snapping every coordinate to the position
returned by a call to the snapToGrid algorithm. Note that the input geometry is not modified but a
new one is created instead.
Another important aspect is that inside the eval clause, the reference to input is not a reference to
the geometry but to the coordinate being evaluated (as stated before the eval expression is
evaluated for each of the input coordinates).
If the input geometry expression is not a variable reference or the name is too long, an alias can be
used. The previous code will look like this using an alias:
show gexp input eval(c| snapToGrid(c));

There are cases where the resulting coordinate cannot be evaluated so easily and it is necessary to
use several statements to do it. In those cases, it is possible to use the do clause, which syntax is as
follows:
gexp <geometric_expression> do [(alias)] {
        <evaluation_block>
}

In those cases, the evaluation_block is a block of code that will contain some return statements that
will set the output coordinate value. The previous examples can be expressed with the do clause:
show gexp input do {
        return snapToGrid(input);
};

and, as seen in the syntax, it is also possible to use an alias:
show gexp input do (c) {
        return snapToGrid(c);
};

Note that the do clause can be understood as an "inline" algorithm, that can hold as many statements
as desired:
geometry referencePoint = POINT(345235 4325299);
show gexp input do (c) {
        if (ST_Distance(c, referencePoint) < 1000) {
                return snapToGrid(c);
        } else {
                return c;
        }
};

Rexp
In the same way gexp lets the user work with the individual coordinates that form a geometry, the
raster expression or rexp can be used to produce a sample value for each individual sample of the
input area.
For example, in order to add the samples of a raster to another raster it is possible to use the rexp
expression and specify an expression involving the desired operation. So, in order to create the
addition of two rasters it is possible to use this code:
raster r1 = ...;
raster r2 = ...;
show rexp r1, r2 eval (r1 + r2);
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The rexp expression consist of the rexp keyword, followed by the raster expressions involved in the
operation. In this case the r1 and r2 rasters are going to be used. Then, an eval clause specifies the
operation to be done with the samples of the rasters.
The output raster will be as big as the first raster (r1) and the i,j sample of the result will be equal to
r1[i,j] + r2[i,j].
It is also possible to specify an alias for the rasters involved in case they have a too long name. They
are specified in the eval clause in the same order than the rasters:
raster myraster1 = ...;
raster myraster2 = ...;
show rexp myraster1, myraster2 eval(r1, r2| r1 + r2);

Note that in the context of the eval clause the raster references become sample references and it is
also possible to reference its x and y position. For example, the following code would create a raster
where the value of the sample will be equal to its x position:
show rexp r1 eval (r1/x);

It is also possible to access a sample relative to the current one so that, for example, the following
code will "move" all samples one position in the upper left direction:
show rexp r1 eval (r1[-1, -1]);

In this case, although the syntax is the same of the absolute sample access seen before (r[x, y]), the
behavior is different. As a rule to differentiate them, relative access takes place only inside rexp
expressions: rexp(r[dx, dy]; while absolute access takes place only outside.
Finally, in case output sample value is too complex to be evaluated in a single expression there is the
possibility to use curly brackets and place several statements there. In order to specify the value of
the sample, a return statement must be used:
multiple_lines = rexp myraster do {
        if (myraster < 100) {
                return 0;
        } else {
                return 1;
        }
}

In case of the do clause, the alias are specified between parentheses:
multiple_lines = rexp myraster do (r1) {
        if (r1 < 100) {
                return 0;
        } else {
                return 1;
        }
}

The output of a rexp expression is a raster as big as the first of the rasters involved in the expression.
However, when no raster is specified, for example to create a new raster with its samples set to a
constant value, a statement like the following one would be used:
show rexp eval (1);

But, as it does not contain any raster reference in the rexp expression, the size and type of the raster
must be explicitly set by an element value that contains the width and height sub-elements:
show rexp eval (1) properties {width=100 height=100};

or if the do clause is used:
show rexp do {
        if (random() < 0.5) {
                return 0;
        } else {
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                return 1;
        }
} properties {width=100 height=100};

This information can also be set explicitly to override the default behavior (taking the size of the first
referenced raster). Thus, it is possible to "cut" a raster:
raster r = ...;
show rexp eval (r) properties {width=r/width:2, height=r/height:2};

Georeferencing
So far, width and height are the only two properties of the raster that have been accessed. But there
are a whole set of properties that deal with the position and size of the raster in the real world: the
georreferencing information.
The georeferencing information is stored in a third property called "georef". It is an element
containing several georeferencing related values. The following table describes the information of
each of the georef sub-element, which is the same information that world files provide (source:
wikipedia):

Sub-element Description
Example (r is a

raster)
sizex pixel size in the x-direction in map units/pixel r/georef/sizex
sizey pixel size in the y-direction in map units/pixel r/georef/sizey
rotationx rotation about x-axis r/georef/rotationx
rotationy rotation about y-axis r/georef/rotationy
ulx x-coordinate of the center of the upper left pixel r/georef/ulx
uly pixel size in the x-direction in map units/pixel r/georef/uly

As width and height, these properties may be used when setting explicitly the raster properties. For
example, the following example applies a dx,dy shift to the raster location in the real world:
raster r = ...;
show rexp r eval (r) properties {georef={ulx=r/ulx + dx, uly=r/uly + dy}};

The default behavior when no georeferencing property is to take the information of the first raster
involved. If neither raster nor georef information is specified, the resulting raster will contain no
georef information.
In order to set the output referencing information to the referencing information of one of the inputs
different from the first one, it is as easy as to set the georef property from the desired raster and set
it in the rexp property section:
show rexp myraster1, myraster2 eval (r1, r2| r-100) properties {georef=r2/georef};

Apart of these properties that let the user know the location of the raster, it is also possible to obtain
the value of the raster in a specific world point. To do so, the at predicate may be used:
t = temperature at (x, y);
show t

In
In checks if a list of values contains a specific element. The syntax is this one:
<expression> in (<list of values>)

Note: This syntax will sound familiar to those users familiar with SQL but it will likely be changed in
the future in order to be able to specify a sequence instead of the <list of values>. The reason it is
not yet changed is because GGL1 is based on SQL and In expression was one of the first expressions
implemented in GGL2 when there was not yet a clear sequence concept.
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The following example will check if a variable call a is equal to 2 or 4:
show a in (2, 4);

Sequence interval
In order to create a sequence of consecutive numbers it is possible to place the inclusive lower and
higher limits separated by two dots:
show 0 .. 9;

Predicates
Predicates are constructions that some action to take place on some value. They syntactically they
both follow the same pattern:
<expression> <predicate> <rest_of_predicate_construction>

Filter predicate

Joins
Joins take two sequence of elements as inputs and produce an output sequence with a combination of
the elements of both input sequences. The combination that are included in the output are those that
match the specified condition.
The syntax for joins in GGL2 is this:
<exp> [as <alias>] join <exp> [as <alias] on (<condition>);

where the two exp are the left and right input sequences respectively.
Consider the following sequences:
places = [
        {the_geom=POINT(0, 0}, id=0},
        {the_geom=POINT(3, 2.5}, id=1},
        {the_geom=POINT(0.2, 12}, id=2}
];

places_info = [
        {id=0, text='El filo de la navaja', menu=true},
        {id=1, text='Los valencianos', menu=false},
        {id=2, text='El rincón de guadalimar', menu=true}
];

In order to get the alphanumeric information of places_info together with the spatial information in
places it is possible to join both tables by using the field id:
result = places as p join places_info as i on (p/id==i/id);

The output sequence will contain elements that are a combination of the elements of both input
sequences. Note that in the previous example there are two id sub-elements in the output element:
[
        {the_geom=POINT(0, 0}, id=0, id=0, text='El filo de la navaja', menu=true},
        {the_geom=POINT(3, 2.5}, id=1, id=1, text='Los valencianos', menu=false},
        {the_geom=POINT(0.2, 12}, id=2, id=2, text='El rincón de guadalimar', menu=true}
];

As it is not possible to have two sub-elements with the same name in the same element, the previous
expression will give a validation error. Indeed, it is necessary to use some other predicates to avoid
the collision:
prefixed_places_info = places_info prefix '_';
result = places as p join prefixed_places_info as i on (p/id==i/_id);
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which will give the following result:
[
        {the_geom=POINT(0, 0}, id=0, _id=0, _text='El filo de la navaja', _menu=true},
        {the_geom=POINT(3, 2.5}, id=1, _id=1, _text='Los valencianos', _menu=false},
        {the_geom=POINT(0.2, 12}, id=2, _id=2, _text='El rincón de guadalimar', _menu=true}
];

Variable references

Readers and writers
In this section the whole list of official readers and writers is described. For every data source type
supported the following data will be provided:

• Library the reader/writer is in.
• Properties accepted.
• Structure of the data accepted by the writer if write is supported.
• Indexing support if present

SHP

DBF

XML
Library: ggl.xml.
Accepts any kind of XML data.
Properties:

Name Description
SchemaLocation Location of the XML schema the root element in the document conforms to.
SchemaLocationsLocation of the XML schemas this document schema uses. It consists of one or

more pairs of URI references, separated by white space. The first member of each
pair is a namespace name, and the second member of the pair is a hint describing
where to find an appropriate schema document for that namespace.

IgnoreSchema Ignore the schema and infer the structure from the XML itself. Useful if the schema
cannot be processed.

PROPERTIES

CSV

GTF

Java mappings
GGL2 has constructions to solve a wide set of tasks. However, it is not a general purpose
programming language so there are problems that cannot be solved with GGL2.
In order to overcome this limitation, some constructions are provided so that it is possible to call Java
code from GGL2. The constructions that specify the java code that is invoked from GGL2 are called
java mappings.
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Currently there are two constructions that allow the mapping to java: readers/writers (the term
"reader" will be used to designate both concepts) and algorithms

Reader java mappings
Readers are a special case since they cannot be implemented in GGL2, only mapped to a Java class.
GGL2 does not have constructions to read the bytes of a file, to connect to an HTTP server to
consume some service, etc. so those tasks, commonly done by readers to provide data to the script,
have to be mapped in all cases. The syntax to do it is the following:
reader PROPERTIES maps to org.gearscape.ggl.readers.properties.PropertyReader;
writer PROPERTIES maps to org.gearscape.ggl.readers.properties.PropertyWriter;

First, the "reader" or "writer" keyword specifies if the java code to map introduces data in the scripts
from existing resources (reader) or takes the data produced in the script and stores it on an existing
resource (writer).
After that, the name of the reader is specified, in this case "PROPERTIES", followed by the "maps to"
keywords and the fully qualified name of the Java class that contains the actual code.
The Java class must implement the org.gearscape.ggl.runtime.Reader interface or, to activate some
optimizations when using the reader, the org.gearscape.ggl.runtime.IndexableReader one.
In order to use the declared reader, it just have to be referenced in a read statement:
read PROPERTIES '/tmp/my.properties' to bati;

which declares a local variable called "bati" which contains the information the reader extracts from
the "/tmp/my.properties" file.

Algorithm mappings
Algorithms, as opposed to readers, can be written in GGL2. But there is also the possibility to execute
Java methods as GGL2 algorithms. These algorithms are defined in the same way normal algorithms
are, except that instead of the body (the list of statements wrapped in curly braces) they contain a
map to a Java method. For example, the following algorithm declaration:
alg sum(double a, double b) returns double maps to org.MyJavaClass::myMappedMethod;

will delegate on the "myMappedMethod" method in the "MyJavaClass::myMappedMethod" class.
In order to make the mapping work, MyJavaClass must be an interface and there must exist a
MyJavaClassImpl class that implements it. The interface (and therefore the class as well) must contain
a method called "myMappedMethod" with the same return value and parameters as the signature of
the GGL2 method. In this case an algorithm that takes two doubles and returns another double:
package ggl;

public interface MyJavaClass {

        double myMappedMethod(double a, double b);
}

In case the type of either a parameter or the return value is not a basic type, some interfaces must be
used, as it can be seen in the following table:

GGL Type Java type
boolean boolean
byte byte
short short
int int
long long
float float
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double double
date java.util.Date
string java.lang.String
geometry com.vividsolutions.jts.geom.Geometry
sequence org.gearscape.ggl.runtime.values.SequenceValue
element org.gearscape.ggl.runtime.values.ElementValue

Core Libraries

Comma-Separated Values (CSV)
To import the CSV core library:
import ggl.csv;

It provides a reader:
/*
 * Reader for comma-separated values (.csv) files.
 */
reader CSV

and a writer:
/*
 * Writer for comma-separated values (.csv) files.
 */
writer CSV

Geometries
To import the Geometries core library:
import ggl.geom;

It provides several algorithms:
/**
 * Returns the name of a geometry's type (point, line,...).
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The name of the geometry's type.
 */
alg ST_GeometryType(geometry thisGeometry) returns string

/**
 * Returns the ID of the Spatial Reference System used by the geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The ID of the coordinate space in which the geometry
 * is defined.
 */
alg ST_SRID(geometry thisGeometry) returns int

/**
 * Sets the ID of the Spatial Reference System used by the geometry.
 *
 * @param thisGeometry A geometry to evaluate.
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 *
 * @return The same geometry with the new Spatial Reference System.
 */
alg ST_SetSRID(geometry thisGeometry, int srid) returns geometry

/**
 * Returns the number of geometries in a geometry collection
 * (or 1, if the geometry is not a collection).
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The number of geometries contained in this geometry.
 */
alg ST_NumGeometries(geometry thisGeometry) returns int

/**
 * Returns a geometry from a geometry collection (or the same geometry
 * if it is not a collection).
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return the n'th geometry contained in this geometry.
 */
alg ST_GeometryN(geometry thisGeometry, int n) returns geometry

/**
 * Returns the count of the geometry vertices.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The number of vertices in the geometry.
 */
alg ST_NumPoints(geometry thisGeometry) returns int

/**
 * Returns whether or not the geometry is simple.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return true if the geometry is simple, false otherwise.
 */
alg ST_IsSimple(geometry thisGeometry) returns boolean

/**
 * Returns whether or not the geometry is valid.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return true if the geometry is valid, false otherwise.
 */
alg ST_IsValid(geometry thisGeometry) returns boolean

/**
 * Returns whether or not the set of points in the geometry is empty.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return True if the geometry equals the empty geometry.
 */
alg ST_IsEmpty(geometry thisGeometry) returns boolean
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/**
 * Returns the minimum distance between two geometries.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return The distance between the geometries.
 */
alg ST_Distance(geometry thisGeometry, geometry thatGeometry) returns double

/**
 * Tests whether the distance from a geometry to another is less than
 * or equal to a specified value.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 * @param distance The distance value to compare.
 *
 * @return true if the geometries are less than distance apart.
 */
alg ST_IsWithinDistance(geometry thisGeometry, geometry thatGeometry, double distance) returns boolean

/**
 * Returns whether or not the geometry is a rectangle.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return true if the geometry is a rectangle, false otherwise.
 */
alg ST_IsRectangle(geometry thisGeometry) returns boolean

/**
 * Returns the area of the geometry (for areal geometries such as
 * polygons or multipolygons).
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The area of the geometry.
 */
alg ST_Area(geometry thisGeometry) returns double

/**
 * Returns the length of the geometry (for linear geometries such as
 * lines or multilines).
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The length of the geometry.
 */
alg ST_Length(geometry thisGeometry) returns double

/**
 * Computes the centroid of a the geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return a point (geometry) which is the centroid of the given
 * geometry.
 */
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alg ST_Centroid(geometry thisGeometry) returns geometry

/**
 * Computes an interior point of the geometry. An interior point is
 * guaranteed to lie in the interior of the geometry, if it possible
 * to calculate such a point exactly. Otherwise, the point may lie
 * on the boundary of the geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return a point (geometry) which is in the interior of the given
 * geometry.
 */
alg ST_InteriorPoint(geometry thisGeometry) returns geometry

/**
 * Returns the dimension of the geometry. The dimension of a geometry
 * is the topological dimension of its embedding in the 2D Euclidean
 * plane. Note that this is a different concept to the dimension of
 * the vertex coordinates. For example, a 0-dimensional geometry
 * (e.g. a point) may have a coordinate dimension of 3 (X, Y, Z).
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The topological dimension of the geometry.
 */
alg ST_Dimension(geometry thisGeometry) returns int

/**
 * Returns the boundary, or an empty geometry of appropriate dimension
 * if the geometry is empty.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The closure of the combinatorial boundary of the geometry.
 */
alg ST_Boundary(geometry thisGeometry) returns geometry

/**
 * Returns the dimension of the geometry's inherent boundary.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The dimension of the geometry's inherent boundary.
 */
alg ST_BoundaryDimension(geometry thisGeometry) returns int

/**
 * Returns the geometry's bounding box.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return An empty point (for empty geometries), a point (for points)
 * or a polygon (in all other cases).
 */
alg ST_Envelope(geometry thisGeometry) returns geometry

/**
 * Tests whether two geometries are disjoint from each other.
 *
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 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the two geometries are disjoint, i.e., they have
 * no point in common.
 */
alg ST_Disjoint(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether a geometry touch another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the two geometries touch; false if both geometrys
 * are points or they don't touch each other.
 */
alg ST_Touches(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether a geometry intersects another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the two geometries intersect, i.e., they have at
 * least one point in common.
 */
alg ST_Intersects(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether a geometry crosses another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the two geometries cross, i.e., they have some but
 * not all interior points in common.
 */
alg ST_Crosses(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether a geometry is within another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the first geometry is within the second, i.e.,
 * every point of the first geometry is a point of the second geometry,
 * and the interiors of the two geometries have at least one point in
 * common.
 */
alg ST_Within(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether a geometry contains another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
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 * @return true if the first geometry contains the second one, i.e.,
 * every point of the second geometry is a point of the first geometry,
 * and the interiors of the two geometries have at least one point in
 * common.
 */
alg ST_Contains(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether a geometry overlaps another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the two geometries overlap, i.e., the geometries
 * have at least one point each not shared by the other (or
 * equivalently neither covers the other), they have the same
 * dimension, and the intersection of the interiors of the two
 * geometries has the same dimension as the geometries themselves.
 */
alg ST_Overlaps(geometry thisGeometry, geometry thatGeometry returns boolean

/**
 * Tests whether a geometry covers another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the first geometry covers the second one, i.e.,
 * every point of the other geometry is a point of this geometry.
 * If either geometry is empty, the value of this predicate is false.
 */
alg ST_Covers(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether a geometry is covered another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the first geometry is covered by the second one,
 * i.e., every point of the other geometry is a point of this geometry.
 * If either geometry is empty, the value of this predicate is false.
 */
alg ST_CoveredBy(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Tests whether the elements in the DE-9IM intersection matrix for the
 * two geometries match the elements in the intersection pattern. For
 * more information on the DE-9IM, see the OpenGIS Simple Features
 * Specification.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 * @param intersectionPattern The pattern against which to check the
 * intersection matrix for the two geometries.
 *
 * @return true if the DE-9IM intersection matrix for the two
 * geometries match the intersection pattern.
 */
alg ST_Relate(geometry thisGeometry, geometry thatGeometry, string intersectionPattern) returns boolean
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/**
 * Tests whether a geometry is equal to another geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the two Geometrys are equal, i.e., the two
 * geometries have at least one point in common, and no point of
 * either geometry lies in the exterior of the other geometry.
 */
alg ST_Equals(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Returns the Well-known Text representation of a geometry. For a
 * definition of the Well-known Text format, see the OpenGIS Simple
 * Features Specification.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The Well-known Text representation of a geometry.
 */
alg ST_AsText(geometry thisGeometry) returns string

/**
 * Computes a buffer area around a geometry having the given width.
 * The buffer of a geometry is the Minkowski sum or difference of the
 * geometry with a disc of radius abs(distance).
 *
 * Mathematically-exact buffer area boundaries can contain circular
 * arcs. To represent these arcs using linear geometry they must be
 * approximated with line segments. The buffer geometry is constructed
 * using 8 segments per quadrant to approximate the circular arcs.
 *
 * The buffer operation always returns a polygonal result. The negative
 * or zero-distance buffer of lines and points is always an empty
 * polygon. This is also the result for the buffers of degenerate
 * (zero-area) polygons.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param distance The width of the buffer (may be positive, negative
 * or 0).
 *
 * @return A polygonal geometry representing the buffer region (which
 * may be empty)
 */
alg ST_Buffer(geometry thisGeometry, double distance) returns geometry

/**
 * Computes a buffer area around a geometry having the given width.
 * The buffer of a geometry is the Minkowski sum or difference of the
 * geometry with a disc of radius abs(distance).
 *
 * Mathematically-exact buffer area boundaries can contain circular
 * arcs. To represent these arcs using linear geometry they must be
 * approximated with line segments. The buffer geometry is constructed
 * using the specified number of segments per quadrant to approximate
 * the circular arcs.
 *
 * The buffer operation always returns a polygonal result. The negative
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 * or zero-distance buffer of lines and points is always an empty
 * polygon. This is also the result for the buffers of degenerate
 * (zero-area) polygons.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param distance The width of the buffer (may be positive, negative
 * or 0).
 * @param quadrantSegments The number of line segments used to
 * represent a quadrant of a circle.
 *
 * @return A polygonal geometry representing the buffer region (which
 * may be empty)
 */
alg ST_Buffer(geometry thisGeometry, double distance, int quadrantSegments) returns geometry

/**
 * Computes the smallest convex polygon that contains all the points
 * in the geometry. This obviously applies only to geometries which
 * contain 3 or more points.
 *
 * If the given geometry contains 0 points, the result is an empty
 * geometry collection.
 *
 * If the given geometry contains 1 points, the result is a point.
 *
 * If the given geometry contains 2 points, the result is a
 * linestring.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The minimum-area convex polygon containing the geometry's
 * points.
 */
alg ST_ConvexHull(geometry thisGeometry) returns geometry

/**
 * Computes a new geometry which has all component coordinate
 * sequences in reverse order (opposite orientation) to the given one.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return A reversed geometry.
 */
alg ST_Reverse(geometry thisGeometry) returns geometry

/**
 * Computes a geometry representing the points shared by two
 * geometries. Geometry collection support intersection with
 * homogeneous collection types, with the semantics that the result
 * is a geometry collection of the intersection of each element of the
 * first geometry collection with the second.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return The points common to the two geometries.
 */
alg ST_Intersection(geometry thisGeometry, geometry thatGeometry) returns geometry

/**
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 * Computes a geometry representing all the points in two geometries.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return A set combining the points of two geometries.
 */
alg ST_Union(geometry thisGeometry, geometry thatGeometry) returns geometry

/**
 * Computes a geometry representing the points making up a geometry
 * that do not make up other. This method returns the closure of the
 * resultant geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return The point set difference of the first geometry with the
 * second.
 */
alg ST_Difference(geometry thisGeometry, geometry thatGeometry) returns geometry

/**
 * Returns a set combining the points in a geometry not in other, and
 * the points in other not in the first geometry. This method returns
 *  the closure of the resultant geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return The point set symmetric difference of the first geometry
 * with the second.
 */
alg ST_SymDifference(geometry thisGeometry, geometry thatGeometry) returns geometry

/**
 * Computes the union of all the elements of a geometry. Heterogeneous
 * geometry collections are fully supported.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The union of all the elements of a geometry.
 */
alg ST_Union(geometry thisGeometry) returns geometry

/**
 * Returns true if the two geometries are exactly equal, up to a
 * specified distance tolerance. Two geometries are exactly equal
 * within a distance tolerance if and only if:
 *      · They have the same class (point, line, ...).
 *      · They have the same values for their vertices, within the
 *        given tolerance distance, in exactly the same order.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 * @param tolerance Distance at or below which two coordinates are
 * considered equal.
 *
 * @return true if the two geometries are of the same class and have
 * equal internal data.
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 */
alg ST_EqualsExact(geometry thisGeometry, geometry thatGeometry, double tolerance) returns boolean

/**
 * Returns true if the two geometries are exactly equal. Two geometries
 * are exactly equal if and only if:
 *      · They have the same class (point, line, ...).
 *      · They have the same values for their vertices, within the
 *        given tolerance distance, in exactly the same order.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
 *
 * @return true if the two geometries are of the same class and have
 * equal internal data.
 */
alg ST_EqualsExact(geometry thisGeometry, geometry thatGeometry) returns boolean

/**
 * Creates and returns a full copy of a geometry.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return A clone of the given geometry.
 */
alg ST_Clone(geometry thisGeometry) returns geometry

/**
 * Converts a geometry to normal form (or canonical form). Normal form
 * is a unique representation for geometries. It can be used to test
 * whether two geometries are equal in a way that is independent of the
 * ordering of the coordinates within them. Normal form equality is a
 * stronger condition than topological equality, but weaker than
 * pointwise equality. The definitions for normal form use the standard
 * lexicographical ordering for coordinates. "Sorted in order of
 * coordinates" means the obvious extension of this ordering to
 * sequences of coordinates.
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return The normalized geometry.
 */
alg ST_Normalize(geometry thisGeometry) returns geometry

/**
 * Returns whether a geometry is greater than, equal to, or less than
 * another geometry.
 * If their classes are different, they are compared using the
 * following ordering:
 *      Point (lowest).
 *      MultiPoint.
 *      LineString.
 *      LinearRing.
 *      MultiLineString.
 *      Polygon.
 *      MultiPolygon.
 *      GeometryCollection (highest).
 *
 * @param thisGeometry A geometry to evaluate.
 * @param thatGeometry Another geometry to evaluate.
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 *
 * @return A positive number, 0, or a negative number, depending on
 * whether the first geometry is greater than, equal to, or less than
 * the second one.
 */
alg ST_CompareTo(geometry thisGeometry, geometry thatGeometry) returns int

/**
 * Returns the maximum X value in a geometry.
 *
 * @param g A geometry to evaluate.
 *
 * @return The maximum X value in a geometry.
 */
alg ST_MaxX(geometry g) returns double

/**
 * Returns the maximum Y value in a geometry.
 *
 * @param g A geometry to evaluate.
 *
 * @return The maximum Y value in a geometry.
 */
alg ST_MaxY(geometry g) returns double

/**
 * Returns the minimum X value in a geometry.
 *
 * @param g A geometry to evaluate.
 *
 * @return The minimum X value in a geometry.
 */
alg ST_MinX(geometry g) returns double

/**
 * Returns the minimum Y value in a geometry.
 *
 * @param g A geometry to evaluate.
 *
 * @return The minimum Y value in a geometry.
 */
alg ST_MinY(geometry g) returns double

/**
 * Returns the X coordinate of a geometry's vertex (usually, but not
 * necessarily, the first one).
 *
 * @param g A geometry to evaluate.
 *
 * @return The X coordinate of a given geometry's vertex.
 */
alg ST_X(geometry g) returns double

/**
 * Returns the Y coordinate of a geometry's vertex (usually, but not
 * necessarily, the first one).
 *
 * @param g A geometry to evaluate.
 *
 * @return The Y coordinate of a given geometry's vertex.
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 */
alg ST_Y(geometry g) returns double

/**
 * Returns the Z coordinate of a geometry's vertex (usually, but not
 * necessarily, the first one).
 *
 * @param g A geometry to evaluate.
 *
 * @return The Z coordinate of a given geometry's vertex.
 */
alg ST_Z(geometry g) returns double

/**
 * Returns the extent of a sequence of geometries, computed as the
 * minimum-area polygon containing all the geometries' envelopes.
 *
 * @param geoms A sequence of geometries to evaluate.
 *
 * @return The full extent of the given geometries
 */
alg ST_Extent(sequenceof geometry geoms) returns geometry

/**
 * Returns the union of a sequence of geometries. This algorithm
 * behaves just as the ST_Union algorithm, but applying to a set
 * of geometries.
 *
 * @param geoms A sequence of geometries to evaluate.
 *
 * @return The union of a sequence of geometries.
 */
alg ST_GeomUnion(sequenceof geometry geoms) returns geometry

/**
 *
 *
 * @param thisGeometry A geometry to evaluate.
 *
 * @return
 */
alg ST_Dump(geometry geom) returns sequenceof geometry

/**
 * Translates the geometry to a new location using the numeric
 * parameters as offsets.
 *
 * @param thisGeometry A geometry to evaluate.
 * @param deltaX The X axis offset.
 * @param deltaY The Y axis offset.
 *
 * @return The translated geometry.
 */
alg ST_Translate(geometry thisGeometry, double deltaX, double deltaY) returns geometry

/**
 * Translates the geometry to a new location using the numeric
 * parameters as offsets.
 *
 * @param thisGeometry A geometry to evaluate.
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 * @param deltaX The X axis offset.
 * @param deltaY The Y axis offset.
 * @param deltaZ The Z axis offset.
 *
 * @return The translated geometry.
 */
alg ST_Translate(geometry geom, double deltaX, double deltaY, double deltaZ) returns geometry

/**
 * Creates a new line from the given origin and destination points.
 *
 * @param p1 The first line's point.
 * @param p2 The last line's oint.
 *
 * @return A new line.
 */
alg ST_MakeLine(geometry p1, geometry p2) returns geometry

/**
 * Computes the angle that the vector defined by this segment makes
 * with the X-axis. The angle will be in the range [ -PI, PI ] radians.
 *
 * @param startPoint The first segment's point.
 * @param endPoint The last segment's point.
 *
 * @return The angle this segment makes with the X-axis (in radians).
 */
alg ST_Angle(geometry startPoint, geometry endPoint) returns double

GIS Applications
To import the GIS Applications core library:
import ggl.gisapps;

It provides a GIS definition for gvSIG:
/*
 * GIS definition for show statements:
 *      show myResult in gvSIG as SHP 'myLayer';
 */
gis gvSIG;

GGL2 Temporary Files (GTF)
To import the GGL2 Temporary Files core library:
import ggl.gtf;

It provides a reader:
/*
 * Reader for GGL2 temporary files (.gtf).
 */
reader GTF

and a writer:
/*
 * Writer for GGL2 temporary files (.gtf).
 */
writer GTF
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Mathematics
To import the Mathematics core library:
import ggl.math;

It provides several algorithms:
/**
 * Returns the pi value.
 *
 * @return The double value that is closer than any other to pi,
 * the ratio of the circumference of a circle to its diameter.
 */
alg pi() returns double

/**
 * Returns the largest double value.
 *
 * @return A value holding the largest positive value of type double.
 */
alg maxDouble() returns double

/**
 * Returns the smallest double value.
 *
 * @return A value holding the smallest positive nonzero value of
 * type double.
 */
alg minDouble() returns double

/**
 * Returns the correctly rounded positive square root of a double value.
 *
 * @param a The value to evaluate.
 *
 * @return The positive square root of a.
 */
alg sqrt(double a) returns double

/**
 * Returns the value of the first argument raised to the power of the second argument.
 *
 * @param a The base.
 * @param b The exponent.
 *
 * @return the value of the first argument raised to the power of the second argument.
 */
alg pow(double a, double b) returns double

/**
 * Returns the greater (closest to positive infinite) of two double
 * values.
 *
 * @param a A value to evaluate.
 * @param b Another value to evaluate.
 *
 * @return The greater of a and b.
 */
alg max(double a, double b) returns double

/**
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 * Returns the smaller (closest to negative infinite) of two double
 * values.
 *
 * @param a A value to evaluate.
 * @param b Another value to evaluate.
 *
 * @return The smaller of a and b.
 */
alg min(double a, double b) returns double

/**
 * Returns the smallest (closest to negative infinity) double value
 * that is greater than or equal to the argument and is equal to a
 * mathematical integer.
 *
 * @param b The value to evaluate.
 *
 * @return The smallest (closest to negative infinity) double value
 * that is greater than or equal to the argument and is equal to a
 * mathematical integer.
 */
alg ceil(double b) returns double

/**
 * Returns the largest (closest to positive infinity) double value
 * that is less than or equal to the argument and is equal to a
 * mathematical integer.
 *
 * @param b The value to evaluate.
 *
 * @return The largest (closest to positive infinity) double value
 * that is less than or equal to the argument and is equal to a
 * mathematical integer.
 */
alg floor(double b) returns double

/**
 * Returns a random double value.
 *
 * @return A double value with a positive sign, greater than or equal
 * to 0.0 and less than 1.0. Returned values are chosen pseudorandomly
 * with (approximately) uniform distribution from that range.
 */
alg random() returns double

Open Geospatial Consortium (OGC)
To import the Open Geospatial Consortium library:
import ggl.ogc;

It provides several type definitions:
/**
 * An element representing a Feature containing a geometry and
 * an integer identifier.
 */
define Feature as element {
        geometry the_geom,
        int id
};
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/**
 * A sequence of Feature elements.
 */
define FeatureCollection as sequenceof Feature;

Properties
To import the Properties core library:
import ggl.props;

It provides several readers:
/*
 * Reader for properties (.properties) files.
 */
reader PROPERTIES

/*
 * Reader for properties (.properties) files. This is simply another
 * alias for the PROPERTIES reader.
 */
reader PROP

and several writers:
/*
 * Writer for properties (.properties) files.
 */
writer PROPERTIES

/*
 * Writer for properties (.properties) files. This is simply another
 * alias for the PROPERTIES writer.
 */
writer PROP

Rasters
To import the Rasters core library:
import ggl.rasters;

It provides several readers:
/*
 * Reader for ascii ESRI grid (.asc) files.
 */
reader ASC

/*
 * Reader for .bmp files.
 */
reader BMP

/*
 * Reader for .gif files.
 */
reader GIF

/*
 * Reader for .jpg or .jpeg files.
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 */
reader JPG

/*
 * Reader for .jpg or .jpeg files. This is simply another alias for
 * the JPG reader.
 */
reader JPEG

/*
 * Reader for .png files.
 */
reader PNG

/*
 * Reader for .tif or .tiff files.
 */
reader TIF

/*
 * Reader for .tif or .tiff files. This is simply another alias for
 * the TIF reader.
 */
reader TIFF

and several writers:
/*
 * Writer for ascii ESRI grid (.asc) files.
 */
writer ASC

/*
 * Writer for .bmp files.
 */
writer BMP

/*
 * Writer for .gif files.
 */
writer GIF

/*
 * Writer for .jpg or .jpeg files.
 */
writer JPG

/*
 * Writer for .jpg or .jpeg files. This is simply another alias for
 * the JPG writer.
 */
writer JPEG

/*
 * Writer for .png files.
 */
writer PNG

/*
 * Writer for .tif or .tiff files.
 */
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writer TIF

/*
 * Writer for .tif or .tiff files. This is simply another alias for
 * the TIF writer.
 */
writer TIFF

NOTE: It is important to notice that all readers (except the ESRI grid reader) will read the associated
world file (.bmp - .bpw, .gif - .gfw, .jpg - .jgw, .png - .pgw, .tif - .tfw) if it exists; and all writers (except
the ESRI grid writer) will write the georeferencing information to a world file if the raster to be written
provides such data.

Strings
To import the Strings core library:
import ggl.strings;

It provides several algorithms:
/**
 * Returns the length of this string.
 *
 * @param thisString The string to evaluate.
 *
 * @return The length of the sequence of characters represented
 * by this object.
 */
alg length(string thisString) returns int

/**
 * Returns true if, and only if, length(thisString) is 0.
 *
 * @param thisString The string to evaluate.
 *
 * @return true if length(thisString) is 0, false otherwise.
 */
alg isEmpty(string thisString) returns boolean

/**
 * Compares two strings, ignoring case considerations. Two strings are
 * considered equal ignoring case if they are of the same length and
 * corresponding characters in the two strings are equal ignoring case.
 *
 * @param thisString A string to evaluate.
 * @param thatString Another string to evaluate.
 *
 * @return true if the arguments represents equivalent strings ignoring
 * case; false otherwise
 */
alg equalsIgnoreCase(string thisString, string thatString) returns boolean

/**
 * Compares two strings. The comparison is based on the Unicode value
 * of each character in the strings.
 *
 * @param thisString A string to evaluate.
 * @param thatString Another string to evaluate.
 *
 * @returns A negative integer if the first string lexicographycally
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